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Seccion 1 - Introduccion al ISE

Introduccion

En este tutorial se presenta la herramienta Integrated Software Environment (ISE) de
la empresa Xilinx. El ISE se usa para modelar, simular y sintetizar disefios a ser
implementados en FPGAs de Xilinx. Aun cuando este tutorial es presentado para
utilizar la herramienta ISE, el flujo a seguir para otra herramienta, por ejemplo el
Quartus Il de Altera, es muy similar.

Con esta herramienta se puede realizar el flujo completo visto durante las clases
tedricas tal como se detalla en la siguiente Figura 1.
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Figura 1 - Flujo de disefio para implementaciéon en FPGA



Uso del ISE

Antes de comenzar a trabajar, por favor cree una carpeta para ser usada como
repositorio de los laboratorios. Utilice el directorio c:\..xxxxx\ como directorio raiz.; y
luego dentro de este directorio va ir creando una carpeta para cada laboratorio. Use
nombres relacionados a los proyectos. Por ejemplo, c:\Curso_ICTP\Lab1\.

Para ejecutar el ISE haga Inicio-> Todos los Programas -> Xilinx Design Tools -> ISE
Design Suite 14.3 -> ISE Design Tools -> Project Navigator

Luego de un corto momento debe aparecer el logo de Xilinx junto con una ventana
pequeia indicando que el programa se esta cargando, tal como se aprecia en Figura
2.

V& N

Project Navigator

Release Version: 14.3
Application Version: P.40xd

Copyright © 1995-2012 Xilinx, Inc.
all rights reserved.

&2 XILINX.

loading libGe_Consoled. ..
Figura 2 - Indicador de que el ISE se esta cargando

La pantalla principal del ISE es la que aparece en la Figura 3, y sus principales paneles
son descriptos a continuacién de la figura.
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Figura 3 - Ventana principal del ISE

Panel 1: Hierarchy, detalla la jerarquia del disefio, es decir los distintos

modules VHDL que componen el sistema, como asi también el test bench

(cuando se selecciona la opcién de Simulation), y también se detalla el

dispositivo a ser usado en la implementacion.

que parte de la jerarquia (panel 1) es la seleccionada.

Panel 2: Procesos: detalla los procesos que se pueden ejecutar dependiendo

Panel 3: Espacio de Trabajo, en este panel se muestra un archivo de VHDL, se

puede mostrar un reporte, o tal como se muestra en Figura 3, se detalla un

resumen del los recursos del FPGA utilizados para el disefio implementado.

Panel 4: Consola, los mensajes de los diferentes procesos que se estan

ejecutando se muestran en este panel. Este panel a su vez tiene diferentes

tabs para ver por ejemplo solo los Warnings, solo los Errores o buscar algunos

caracteres en particular.




Creacion de un Proyecto en ISE

Hay varios pasos para crear un proyecto en el entorno ISE, los que se detallan a
continuacion.

a. En la barra del menu seleccione File->New Project. La ventana de opciones de
un nuevo proyecto aparecera.

b. Introduzca el nombre del laboratorio, y navegue para encontrar el directorio
ya creado o cree uno para este laboratorio.

c. Seleccione tipo HDL desde la opcion Top Level Source Type. Finalizados los
pasos a-c, se debera tener una ventana similar a la que se ve en Figura 4.

™ New Project Wizard X

Create New Project
Specify project location and type.

Enter a name, locations, and comment For the project

Mame: \ Labl_deco_3a8 ‘
Location: ’F:'LCurso_ICTP_Zﬂl21Lab11Lab1_deco_3a8 ‘ Q
\Working Directory: [F:1Curso_ICTP_20121Lab11Lab1_deco_3a8 ‘ E]
Description: Laboratorio 1 del Curso ICTR, YHDL-FPGA.

Select the type of top-level source for the project

Top-level source type:

HOL v|

Mext = ][ Cancel ]

Figura 4 - Configuracién proyecto nuevo. Paso 1

d. Presione Next. Las siguientes opciones estan referidas a la seleccidon del FPGA 'y
flujo de ejecucion del laboratorio. Como en los laboratorios seran usadas unas
placas de desarrollo que utilizan un FPGA especifico, por favor asegurese de
seleccionar el siguiente FPGA a fin de evitar problemas: Spartan 3E-500 FG320.

La siguiente figura detalla las configuraciones de este paso.



* New Project Wizard

Project Settings
Specify device and project properties.

Select the device and design fFlow For the project

Property Name Value

Evaluation Develobment Board None Specified v
Product Cateqory Al v
Familv Spartan3E v
Device KC3S500E v
Packaae FG320 v
Speed -5 v
Tob-Level Source Tvbe HDOL

Svnthesis Tool XST (VHDL Verilog) v
Simulator I1Sim (VHDL /Verilog) v
Preferred Lanauaae VHDL v
Proberty Specification in Proiect File Store all values v
Manual Compile Order O

VHDL Source Analvsis Standard VHDL-93 v

23

AL

[ < Back ][ Next = ][ Cancel ]

Figura 5 - Detalle del FPGA a ser usado para implementar el disefio en la Nexys 2

e. Al hacer click en Next, una ventana resumiendo la configuracion del proyecto
es mostrada tal como se detalla en Figura 6.



* New Project Wizard X

Project Summary
Project Mavigator will create a new project with the Following specifications.

Project:
Project Nawe: Labl deco_3ad
Project Path: F:\Curso_ICTP_2012\LabliLabl deco_3ad
Working Directory: F:\Curso_ ICTP_2012\LabliLabl_deco_3ad
Description: Laboratorio 1 del Curso ICTP, VHDL-FPGA.
Top Level Source Type: HDL

[>

Device:
Device Family: Spartan3E
Device: xc3s500e
Package: fg3z20
Speed: -5

Top-Level Source Type: HDL

Synthesis Tool: XST (VHDL/Verilog)

Simulator: ISim (VHDL/Verilog)

Preferred Language: VHDL

Property Specification in Project File: Store all values
Manual Compile Order: false

WVHDL Source Analysis Standard: VHDL-93

< Back ]l Finish ][ Cancel

Figura 6 - Resumen de la configuracion del proyecto

f. La ventana de nuevo proyecto debe aparecer, similar a la mostrada en la
siguiente figura.

|Design <05 X‘
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]| - © Labl_deco_3a8
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Empty Yiew
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- The view currently contains no files, You can add files to
the project using the toolbar at left, commands from the
Project menu, and by using the Design, Files, and
Libraries panels.

Use:

 New Source: To create a new source file.

* Add Source: To add an existing file to the
project,

* Add Copy of Source: To copy an existing file to
the project directory and add it to the project.

Figura 7 - Proyecto recién creado



Hay dos opciones en esta ventana con respecto a los cddigos fuentes. Una
opcion es agregar un archivo .vhd que ya ha sido escrito (por ejemplo para
otro proyecto), y la otra opcion es crear un nuevo archivo .vhd. En este ultimo
caso crea una entidad y arquitectura en funcion de las entradas y salidas que
se definen en las respectivas opciones. Para acceder a estas dos opciones se
presiona el botén derecho del mouse y se elije la opcidn que desee, tal como
se puede apreciar en Figura 8.
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Figura 8 - Seleccidon de archivos .vhd a ser agregados al proyecto

a) Para el caso de querer agregar un cédigo ya escrito se deben realizar los
siguientes pasos:

1. El archivo a ser agregado puede ser copiado a la carpeta de trabajo, o
puede ser referenciado. Desde la ventana de ‘New Project window”,
haga click en Next, y luego en Add Source. Esto abrira la ventana de
opciones.

2. Usando el navegador, selecciones el directorio y luego el archivo a ser
agregado



3. Esta ventana tiene una opcidn para copiar el archivo en la carpeta del
laboratorio. Por cada archivo a agregar se realiza el mismo
procedimiento.

4. Una vez concluido el proceso de agregar los archivos, click Next para ver
la informacidn relativa al proyecto recién creado.

b) Para el caso de querer crear un nuevo archivo .vhd, ejecute los siguiente
pasos:

a. En el dialogo ‘Create a New Source’, click ‘New Source’, y especifique el
tipo, VHDL, el nombre y la locacién del archivo. Ver

™ New Source Wizard X

Select Source Type
Select source type, file name and its location.

% IP (CORE Generator & Architecture Wizz
[2] Schematic

* Systemn Generator Project

(2] User Document

Verllog Module

W] Verilog Test Fixture 72T
[ VHDL Module |deco_3ad] ‘
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Figura 9 - Especificaciones del archivo .vhd a ser creado

b. La ventana de dialogo de nuevo archivo aparecerd. Introduzca los
nombres de los puertos, y la respectiva direccidn e indique si alguno de
los puertos es un bus. Tal como detalla figura xxxxx



™ New Source Wizard X

Define Module
Specify ports for module.

Entity name ’ deco_3a8 ‘

Architecture name \hehavioral ‘

Port Name Direction Bus MSB LSB

entrada_deco in N 2 0
salida_deco out N 7 0 =
in viO

O

O v

[ < Back ]l MNext = ][ Cancel ]

Figura 10 - Detalle puertos E/S del .vhd a ser creado

c. Click Next, un resumen de los puertos de entrada y salida se detallan,
compruebe que los datos sean correctos. Luego presione Finish.

d. Esta ultima accidn, incorpora el .vhd recién creado al proyecto y lo abre
en la ventana del editor de texto.

FLUJO DE DISENO DEL ISE
Una vez creado el proyecto la ventana del ISE muestra la siguiente informacion

a) Enforma jeradrquica muestra los componentes del disefio
b) Los procesos que pueden ejecutarse

c) El estado del proyecto

d) El resumen del disefio implementado en la FPGA.

Una marca verde de chequeo exitoso (check mark) al costado de cada modulo indica
que el archivo ha sido incorporado al proyecto. Por otro lado, un signo de pregunta,
?, indica que el archivo aun no es parte del proyecto.

1. Synthesize
El proceso de sintetizar el disefio chequea primero la sintaxis de todos los modulos
componentes del proyecto conforme al estandar VHDL, y luego realiza la sintesis
respectiva. Presione dos veces la opcidon de Synthesize — XST. Si el proceso termina
exitosamente una marca de chequeo verde aparece al costado del proceso de



sintesis, de lo contrario una ‘X’ roja es mostrada al costado del modulo con error.
Informacién detallada del proceso de sintesis es mostrada en la consola del ISE
(ventana inferior).

2. Vista RTL del Diseio
Finalizado el proceso de sintesis, se puede hacer dos clicks sobre el proceso View RTL
Schematic, tal como se detalla en Figura 11.

» | ¥) Mo Processes Running

Processes: deco_3a8 - behavioral

E  Design Summary/Reports
#® %  Design Utiites
¥  User Constraints
= €2  Synthesize - XST
[®  View Technology Schematic
€2 Check Syntax
€) Generate Post-Synthesis Simulation M...
# 82 Implement Design
€2 Generate Programming File
® Configure Target Device
€+ Analyze Design Using ChipScope

T
& Start | B3 Design ’lq_'] Files | [ Libraries

Figura 11 - Seleccidn del proceso View RTL Schematic

Como resultado de la ejecucidn de ese proceso se debe tener una vista del
esquematico que se genera de la informacion suministrada por la herramienta de
sintesis.

El reporte de sintesis contiene informacidn describiendo el progreso y resultado de
sintesis. Para abrirlo se debe hacer click Synthesis Report de la opcién Detailed
Report, tal como se muestra en Figura 12
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* Final Report *

Final Results

RTL Top Level Output File Name : deco_generic.ngr
= Errors and Warnings Top Level Output File Name : deco_generic
[2 Parser Messages Output Format ¢ NGC
Optimization Goal : Speed
Keep Hierarchy : No

Design Statistics

# I0s : 12
g Cell Usage :
@ Al Implementation Mes... # BELS ¢ 8
= Detalled Reports # Lo P8
P . # I0 Buffers : 12
[ Synthesis Report 4 IBUF . q
] # OBUF : 8
[ Map R
O Place
—] P Device utilization swanary:
OF eport
[ Bitgen Report Selected Device : 3s500efg320-5
Secondary Reports =
— Nuber of Slices: 4 out of 4656 0%
Synthesis Report | Nurdber of 4 input LUTs: 8 out of 9312 0%
Top of Report Nurber of IOs: 1z
Synﬂﬂesis Opu’ons Summary Nuber of bonded IOEs: 12 out of 232 5%
HOL Compilation
Design Hierarchy Analysis Partition Resource Swmmary:
HOL Analysis
= HDL Synthesis
HOL S\mthesis Report No Partitions were found in this design.
= Advanced HDL Synthesis
Advanced HOL Synthesis R...
Low Level Synthesis ¥ |«
deco_generic.vhd X Design Summary (Synthesized) @;’ Q deco_generic (RTL1) [ E deco_generic (Tech1) ‘ Q deco_generic (RTL2)

Figura 12 - Ejecucion del reporte de sintesis

3. Implementacion del Disefio

El proceso de implementacion del disefio, Implement Design, crea el hardware del

disefio. Hay varios procesos relacionados con la implementacion del disefio:

Translate: crea una base de datos interna del disefio. Esto puede incluir una
variedad de formatos tales como VHDL, EDIF netlist, etc. Todos estos formatos
son convertidos y unidos en un ne;tlist con un formato dado por Xilinx.

Map: este proceso mapea la légica generada en el proceso de Translate en
hardware de la FPGA (CLBs, I0Bs, BRAM, etc). Este paso también optimiza ldgica, y
remueve logica no usada.

Place and Route (P&R): este proceso asigna CLBs, I0Bs, BRAMs, especificos del
FPGA y los respectivos ruteos de interconexidén de logica. Si una restricciéon de
tiempo ha sido establecida sera usada para guiar la locacion de la légica. El ruteo
del disefio también sera controlado por la locacion de los pines de E/S. El reporte
de P&R indica la calidad del ruteo, un resumen de timing, y si alguna sefial no ha
sido exitosamente ruteada.



A los fines practicos de este curso, se puede ejecutar cualquiera de los procesos
contenidos dentro del proceso de P&R. Al ejecutarse uno de estos procesos todos los
procesos anteriores seran ejecutados también. Por ejemplo la siguiente figura
muestra la opcidon de seleccionar el proceso de Generate Post Place and Route Static
Timing.

¥ Mo Processes Running

Processes: deco_generic - behavioral —

L Design Summary/Reports
Design Utlites
User Constraints

© Synthesize - XST
Implernent Design

)  Translate

@ Map

€2 Place & Route

@ 1
Analyze Timing / Floorplan Design (PlanAhead)
Wiew,/Edit Routed Design (FPGA Editor)
8  Analyze Power Distribution (XPower Analyzer)
€) Generate Text Power Report =

& Start } &2 Design ]lu Files | [ Libraries

2 v

=+

<
)
i) cs@@

}

+.

Figura 13 - Ejecucion del proceso Generate Post Place and Route Static Timing

Finalizada la ejecucién de cualquiera de los procesos de Implement Design, es muy
conveniente leer alguno de los distintos reportes generados.

Los reportes se encuentran en la columna del medio del panel principal. De acuerdo
al reporte que se seleccione es como cambia la parte inferior de la mencionada
columna. La siguiente figura detalla lo escrito.



O 2 Timing Constraints A
A

= Pinout Report
€] [ Clock Report
© @ Static Timing

¢ = Errors and Warnings
=2 Parser Messages

- 2 Synthesis Messages
8 B Translation Messages
2 Map Messages
4 2 Place and Route Messa...

B Timing Messages

2 Al Implementation Mes...
= Detailed Reports
2 Synthesis Report
2 Translation Report
] Map Report
[E Post-PAR Static Timing ...
[] Power Report
[ Bitgen Report
Secondary Reports

<

Place and Route Report
Top of Report
Router Information
Partiton Status
Tirming Results
Final Summary

Figura 14 - Distintos reportes disponibles

4. Generacion del Archivo de Programacion del FPGA
El dltimo paso en el proceso del disefio es la creacidon de un archivo de programacién
conteniendo toda la informacién para configurar el FPGA. Este archivo se le llama
bitstream. Realice los siguientes pasos para generar el mencionado archivo:

1. Seleccione el proceso ‘Generate Programming File’. Haga click en el
botdon derecho del mouse y seleccione Propiedades. En Category
seleccione Startup Options, y cambie el valor por defecto (CCLK), por
JTAG Clock, tal como muestra Figura 15. Haga click en Apply para
aceptar los cambios.



8 © Process Properties - Startup Options @

Category Properties are not editable while a process is running.
Gen?ral Options Switch Name Property Name Value
Configuration Options '
Startup Options -g StartUpClk:  FPGA Start-Up Clock JTAG Clock
Readback Options -g DonePipe:  Enable Internal Done Pipe
-g DONE_cycle: Done (Qutput Events) Default (4)

-g GTS_cycle:  Enable Outputs (Quiput Events) Default (5)
-g GWE_cycle: Release Write Enable (Qutput Events) |Default (8)
-g LCK _cycle:  Wait for DLL Lock (Qutput Events)  |Default (No' v
-g DriveDone:  Drive Done Pin High O

Property display level: Display switch names

Figura 15 - Configuracion del reloj para programar el FPGA

2. Doble click sobre el proceso ‘Generate Programming File’ (a veces
aparece un mensaje preguntando si desea habilitar el envio de
informacién a Xilinx, para sus estadisticas, se sugiere declinar dicha
invitacion para evitar el flujo de informacién). Si el archivo de
configuracidn (conocido como bitstream) se genera exitosamente, un
check mark verde aparece al costado del proceso.



TUTORIAL ISim

Creando el Test Bench

Si no tiene abierto el proyecto, abralo ejecutando File->Open Project.

Una vez abierto el proyecto, para crear el respectivo Test Bench apriete el botén
derecho del mouse sobre el dispositivo en la ventana de fuentes (Sources), y elija
New Source. En la ventana de New Source, elija VHDL Test Bench, e introduzca el
nombre del test bench, tal como se muestra en Figura 16.

™ New Source Wizard X]

Select Source Type
Select source type, file name and its location.

BMM File A
€* ChipScope Definition and Connection F
[ Implementation Constraints File

% IP (CORE Generator & Architecture W

MEM File File name:
[2] Schematic :
» System Generator Project |deco_3a8_tb |
2] User Document Location:
¥eriog Mocwes FAICTP_20121Labsllab1iLab1_deco_3a8 (o)

W] Verilog Test Fixture
YHDL Module
0 vHDL Library

[¢] VHDL Package 4

B VHOL Test Bench 8

< | b Add to project

I Next > ][ Cancel ]

Figura 16 - Nuevo test bench a ser agregado al proyecto

Una vez seleccionado el nombre y la locacién del Test Bench, clikc Next. En la ventana
que aparece debe seleccionar con cual archivo .vhd desea asociar el test bench a
escribir. Seleccione cuidadosamente el archivo correspondiente.



Complete la creacién del nuevo Test Bench by clicking Next y Finish. Para ver y editar
el Test bench, primero debe cambiar la opcién del menu de ‘Sources For desde
Implementation a Behavioral Simulation, tal como muestra en Figura 17.

Design 048 X

[ | View: O {8 implementation & 4 Simulation

EE] Behavioral v

%) | Hierarchy

. ] Lab1_deco_3a8

| = €3 xc3s500e-5fg320

2| = deco_3a8_tb - behavior (deco_3a8_tb.vhd)

uut - deco_generic - behavioral (deco_gener
< >

Figura 17 - Opciones del ISE para simulacion

Una vez realizado el cambio, los archivos .vhd del panel de Sources cambian de
orden, siendo el test becnh ahora el primer archivo desde arriba hacia abajo. En el

panel de procesos (Processes) la Unica opcion es la del simulador del ISE llamado
ISim.



Design 08 X

[ | View: O & implementation & f# Simulation
@ Behavioral v

7] | Hierarchy

= ] Labl_deco_3a8
= £ xc3s500e-5fg320

PSRN % deco_3a8_th - behavior (deco_3a8_tb.vhd)

uut - deco_generic - behavioral (deco_gener

» | #) Mo Processes Running

4. | Processes: deco_3a8_tb - behavior
=% 1Sim Simulator

= ) Behavioral Check Syntax
Simulate Behavioral Model

& Start ‘ B Design Mj Files | [ Libraries

Figura 18 - Seleccién de herramienta de simulacién ISim

Archivo Test Bench

Abra el test bench recién creado al hacer doble click en el respectivo archivo en la
ventana de sources. Aparecera en el editor de texto el .vhd correspondiente. El
cddigo generado incluye lo siguiente:

* Definicion de las librerias

* Laentidad (entity)

* Laarquitectura

* Un bloque de instanciacidn

El cédigo generado es realmente un patrén genérico, por lo que para disenos
complejos puede ser que el test bench generado sea muy sencillo, mientras que para
disefios simples algunas partes deben ser removidas. Una de las primeras cosas a
modificar es la constante <clock>_period. Verifique también los valores iniciales
asignados por defecto. Agregue las lineas de cddigo que considere necesarias para
generar los estimulos. Recuerde también de agregar cédigo de verificacién en caso
que asi lo desee.



Despues de realizar los respectivos cambios, grabe al archivo.
Para ejecutar el test bench, haga doble click en Simulate Behavioral Model.
ISim

Una vez abierto el ISim se tienen cuatro paneles principales, detallados en la Figura
19.

2% Isim (P.40xd) - [Default.wcfg] FEX)
=] File Edit View Simulation Window Layout Help -8 %
D2H “iasaBDDBEX® vwao Mx QD BFENT LR AL A P e & 0 » HX 100 ¥6 I »
Instances and Processes + 0O & X Objects <08 X # 5
MR EEFEER SE“I'E“;:TTSIFW dec- B
) ; { /1B »
Instance and Process Name  Design Unit  Blc ‘7?
i deco_3a8_tb deco_3a8_tb(... Y¥HDL Object Name e #
() std_logic_1164 std_logic_1164  YHDI ?‘5 sel[2:0] 1@ O1111111
(%) numeric_std numeric_std VHDL U@ en 1 O
7‘3 y_n[7:0] [1}
1 w
< > 2 M
g,% Instances and Processes Memory 3 Source Files | | ¢ (|| [ Default.wecfg
Console + 0 & X CompilationL... ¢+ 0O & X
~
This is a Full version of ISim.
Time resolution is 1 ps
Simulator is doing circuit initialization process. 4
Finished circuit initialization process.
ISim>

v
[@ console | @ Breakpoints | [@§ Find in Files Results fn Search Results

Sim Time: 1,000,000 ps

Figura 19 - Paneles principales del ISim

Panel 1: panel de Source Files, para la seleccién de archivos fuentes.
Panel 2: panel de Objetos, detalla las sefales que se pueden agregar a la simulacidn.

Panel 3: panel de Simulacién, donde el estado de las sefiales y sus respectivas formas
de ondas pueden ser observadas.

Panel 4: Panel de Consola, donde los mensajes relativos a la simulacion se detallan.

Algunas herramientas utiles del I1Sim:

* Elicon ‘Zoom to Full View’, se usa para tener una vista completa de la
simulacién.

Zoom to Full View

* Paraver mas detalles de la simulacidn, use la lupa con al signo mas (+).



* En la parte izquierda del panel de simulacion hay dos columnas
denominadas Name y Value. Para una sefal determinada puede hacer
click sobre el botén derecho del mouse, y seleccionar la opcidon de
borrar, renombrar o cambiar de color. Las sefales se pueden arrastrar
para arriba o para abajo. Otra opcidn util es agregar ‘New Divider’, para
separar las sefiales por funcionalidad por ejemplo.

* El bloque de control de simulacion, sobre la parte derecha del menu de
barras del I1Sim,

@ » X t00us v 6= ||

tiene las siguientes caracteristicas:
O Re-comienzo de simulacion, la detiene y vuelve el tiempo de

simulacién a 0. &
O Ejecuta la simulacion hasta q todos los eventos son ejecutados

4
O Ejecuta la simulacion por el tiempo especificado en la caja de
X
valor de tiempo "
Valor de tiempo, y unidad de tiempo 120 ¥
b=

Ejecuta la simulacién, una instruccion por vez
Pausa la simulacidn

O O 0O O

Detiene la simulacion

Ejecucion de Simulacidon Post Place and Route
Para la ejecucion de la simulacidn post place and route se debe seleccionar la
simulacioén post route desde el menu de simulacion.



IDesign <08 X
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uut - deco_generic - behavioral (deco_gener

Figura 20 - Configuracion para simulacién post place and route

La opciéon del proceso de simulacidon cambia adecuandose a lanueva simulacién
requerida.

|Design «+0& X

] | View: O {8k implementation & ff Simulation

Post-Route v

Hierarchy

] Lab1_deco_3a8
= 62 xc3s500e-5fg320
= [k deco_3a8_tb - behavior (deco_3a8_tb.vhd)
uut - deco_generic ()

¥ Mo Processes Running

Processes: deco_3a8_tb - behavior

=¥  I1Sim Simulator
f) Post-Place & Route Check Syntax

Simulate Post-Place & Route Model

H 8298 vV |«B/( M i 5

& Start ‘ B Design ‘ [ Files H [y Libraries ‘

Figura 21 - Simulacién post place and route

Haciendo doble click sobre Simulate Post-Place and Rout eModel se abre ISim. Es
conveniente correr la simulacidn, y luego expandir las formas de ondas hasta que
pueda visualizar algun retardo, tal como se muestra en la siguiente figura. Use
cursores para facilitar la localizacion y el calculo del retardo.
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Figura 22 - Simulacion post P&R y medicion de retardo

Otras Herramientas utiles del ISE
Para los que estén interesados en el uso de herramientas mas avanzadas se detalla
a continuacion las mismas y su forma y propdsito de uso

Analyze Post-Place & Rout Static Timing

Este proceso se ejecuta hacienda doble click en el proceso respectivo tal como se
detalla en la siguiente figura.

» | F) Mo Processes Running

T4, | Processes: tc_amba_core - structural e
=1 # A\ Map
a = 0@ Place & Route

= 0@ Generate Post-Place & Route Static Timing

n €  Analyze Post-Place & Route Static Timing

)  Generate Primetime Netlist
€ Analyze Timing / Floorplan Design (PlanAhead)
View/Edit Routed Design (FPGA Editor)
8  Analyze Power Distribution (XPower Analyzer)
€d Generate Text Power Report
€) Generate Post-Place & Route Simulation Model
* Q Generate IBIS Model o

& Start | B Desgn mj Files [E lerarles

Figura 23 - Ejecucion del proceso de analisis estatico de tiempo del disefio

Los resultados de la ejecucidon de la herramienta de analisis estatico de tiempo se
presentan en forma de texto en la pantalla principal. El camino mas lento, camino



critico, se puede en el Technology Viewer al presionar boton derecho del mouse y
seleccionar Show in Technology Viewer, tal como se detalla en Figura 24.

~
Slack: 80.%941lns (requirement - {(data path - clock path skew + uncertainty)) D
Source: baud_rate _gen ifcount xl6 _divZ 0 (FF)
Destination: baud _rate gen i/fcount x16_diwZ 15 (FF) 1
Requirement: 83.330ns
Data Path Delay: 2.389ns (Levels of Logic = 3)
Clock Path Skew: 0.000ns
Source Clock: CLOCK_BUFGP rising at 0.000ns
Destination Clock: CLOCK_BUFGP rising at 83.330ns
Clock Uncertainty: 0.000ns
Maximum Data Path: baud rate_gen ifcount x16_diwg—O—s=trssdssmbn snman i fmmssmt sl dinn 3§
Location Delay type Delayir c) Reloa
View 4
SLICE_X439Y153.YQ Tcko 0.2g
©] i i
SLICE_X48YlS5Z.FZ net {fanout=2) 0.3% ShOW in FPGA EdItOr
SLICE_X48Y152.COUT  Topcvf WL i Show in Technology \iewer livz_cy<l>
rt
d livz_cy<0=
4 Find... Chl4+F ===
livZ_cy<l>
SLICE_X48Y153.CIN  net {fanout=1} 0.0 Find Next F3 livz_cy<l>
SLICE_X48Y1S53.COUT Thyp 0.0¢ livZ_cy<3>
Select Al Crl+A vz cy=z> ¥

Figura 24 - Seleccidn de la opcion de vista del camino critico

El resultado de la vista en el Technology Viewer es un circuito esquematico del
camino critico tal como se aprecia en Figura 25.

@ Ijlj._&ﬁ _;zﬁf;jjifﬁ_"ﬁ_";tbﬁ _;B_"-;Irifﬁ _EL_U:EJF _'ﬁj;c&ﬁ __z:f_‘nﬁﬁ g

Figura 25 — Detalle en forma de esquematico del camino critico

Pad Report

Este es un reporte muy importante ya que detalla la informacién relacionada a la
asignacion de los pines de E/S del FPGA vy las sefiales de E/S del sistema descripto en
VHDL. Para la ejecucién del mismo presione dos veces sobre Pinout Report en la
columna del medio del resumen de disefo.



(| & Design Overview Pin  Signal . Pin Pin Drection . 10 OBarl rive Sew ..
o) % Surnmary Aumbel  Name Usage Name standarc \umbel mA} ate
10B Properties
o B Modue Level Utiization 1 U0 ADDR<0O> OB 10_L16P_13 OUTPUT LVTTL 13 12 SL.. NONE®*
o B Timing Constraints 2 T30 ADDR<10> IOB 10_L13N_13 OUTPUT LVTTL 13 12 SL.. NONE**
@ 'tt 3 T8 ADDR<ii> |IOB  10L12P_13 OUTPUT LYTTL 13 12 SL.. NONE**
48 | © Errors and Warrings 4 P31 ADDR<12> OB 10_L7N_13 OUTPUT LVTTL 13 12 SL.. NONE**
o % Fs’afig "_"elfjages 5 U28  ADDR<13> IOB [O_L12N_VREF_.. OUTPUT LVTTL 13 12 SL... NONE**
Yoesis Viessages
B Translation Messages 6 R33 ADDR<14> IOB I0_L11N_13 OUTPUT LVTTL 13 12 SL.. NONE®*
g I"|1ap Mezsages 7 ¥33 |ADDR<1> IOB 10_L17P_13 OUTPUT LVTTL (13 12 SL.. NONE**
Place and Route Messages .
B Tiring Messages 8  v34 ADDR<2> IOB [0_L17N_13 OUTPUT LVTTL 13 12 SL.. NONE
Bitgen Messages 9 U3l ADDR<3> IOB 10_L16N_13 QUTPUT LVTTL (13 12 SL.. NONE*®*
B Al Current Messages 10 U2 ADDR<4> IOB 10_L15P_13 OUTPUT LVTTL 13 12 SL.. NONE**
= Detailed Reports
B Synthesis Report 11 T29 ADDR<S> IOB 10_L13P_13 QUTPUT LVTTL (13 12 SL.. NONE**
g l\T/rla”SF'{aUO”tReDOFt 12 |T33 ADDR<6> IOB 10_L14P_13 OUTPUT LVTTL 13 12 SL.. NONE**
ap Repor
B Place and Route Report 13 U33 ADDR<7> ICB I0_L18N_13 OUTPUT LVTTL 13 12 SL.. NONE**
[ Static Timing Report 14 R27 ADDR<8> IOB 10_L4P_13 OUTPUT LVTTL 13 12 SL.. NONE**
S Bitgen Report 15 R29 ADDR<9> OB [0_LSN_13 QUTPUT LVTTL 13 12 SL.. NONE**
econdary Reports

Figura 26 — Reporte de los pines E/S del FPGA

Haciendo simple click sobre ‘Signal Name’ se muestran las sefiales en orden
alfabético.

Tambien se puede usar el siguiente proceso para verificar la asignaciéon de pines de
E/S, ver Figura 27.

» | ¥ Mo Processes Running

>

Processes: tc_amba_core - structural

€ Analyze Timing / Floorplan Design (PlanAhead)
(2} View/Edit Routed Design (FPGA Editor)
8  Analyze Power Distribution (XPower Analyzer)
) Generate Text Power Report
) Generate Post-Place & Route Simulation Model
)  Generate IBIS Model
= € Back-annotate Pin Locations
%) Generate Programming File
3 Configure Target Device
€ Analyze Design Using ChipScope

" Start ‘ B3 Design H(j Files | [y Libraries

AR

<

<

Figura 27 - Verificacién de pines de E/S

FPGA Editor

Esta herramienta permite visualizar la locacidn de los distintos elementos logicos del
disefio y su respectivo ruteo. La siguiente figura, Figura 28, detalla el proceso a ser
invocado para su ejecucion.



€ Running: FPGA Editor

i1 |Processes: tc_amba_core - structural

£ # 0O Translate
3t # T4\ Map
= 0@ Place & Route
= 0@ Generate Post-Place & Route Static Timing
&  Analyze Post-Place & Route Static Timing
)  Generate Primetime Netlist
[€ Analyze Timing / Floorplan Design (PlanAhead)

View/Edit Routed Design (FPGA Editor)
8  Analyze Power Distribution (XPower Analyzer)
€) Generate Text Power Report
€2 Generate Post-Place & Route Simulation Model =

& Start | B8 Design | U] Files [y Libraries

Figura 28 - Ejecucion de la herramienta FPGA Editor

Una vez ejecutado el comando la ventana del FPGA Editor aparece, Figura 29

muestra una vista de un disefio.

X| 2 List1

[anNets

Name Filter

[ =
““““ Name Fanout| Max Pin| Hilited ] ~

1 baud_rate_gen_i/cl EM'

2 RESET_IBUF_1 |53 |2 [omate |

3 RESET_IBUF |45 |2 [fuquose |

4 GLOBAL_LOGICT (27 |2 [rocoer ]

5 NO1 19 |2 [rocoor ]

3 N11 19 |2 M

7 teb_serial_ty_ifts_c 18 ? [ocoor |

8 tca_senial_ts_ifts_c 18 ? [ocoor ]

9 baud_rate_gen_i/ |17 ?

10 baud_rate_gen_i‘c| 16 ?

11 rom_if_i/NO 15 ? [hocoler ]

12 tca_serial_tx_ifts_c|12 ? [hocoler ]

13 KIL_ML_PMV_0OU |12 ? no color

14 tch_serial_tx_ifts_c 11 ? no color

15 teb_serial_tw_ifts_c/ 11 32 [hocolor | |

16 |teh_serial_te_ifts_c 11 ? [hocoor

17 tca_serial_ty_ifts_c 11 ? Tv

18 tca_serial_ty_ifts_c/11 ? [ocoor |

19 teb_serial_ts_ifts_c/ 11 ? [ocoor |

20 tca_serial_tx_iftx_c 11 ?

21 teh_serial_t«_ifent |11 ?

tca_serial_t«_ifent |11 ? [hocoler ] 3

Figura 29 - FPGA Editor



